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SUPERFOX “Quick Start” TUTORIAL 
 
 
 

Welcome to the SuperFox Quick Start Tutorial 
 
 
This tutorial will help you become accustomed to SuperFox within a 3 hour 
training workshop. It will make it easy for you to get started with SuperFox 
and work with mini-guides that come with SuperFox later at your own pace. 
 
 
This Tutorial is split into five sections: 

 
Section 1   An introduction to SuperFox and a quick tour of the program, where to find help. 
 
Section 2   We will be entering family details. 
 
Section 3   Using the calendars and setting up your services. 
 
Section 4   We will be entering some bookings, payments received and invoicing. 
 
Section 5   Free Entitlements and Management Reports. 
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“Quick Start” Section 1 
  INTRODUCTION TO SUPERFOX 
 

 

SuperFox is a simple back-office administration program for childcare providers. To get a feel for 
SuperFox, we are going to start up SuperFox on your computer and take you through some sections of 
the program and look at some of the printed reports that SuperFox can produce. 

 

1. Sequence that Information Goes In 

When we set up SuperFox we will start by entering primary data about the 
setting, families, our staff and the services that we provide.  
 
You will need to do this for your setting in this order too: 
 

 Open the program and enter passwords. 
 Enter setting details 
 Enter staff details 
 Enter family details 
 Set up the services that we provide (care required). 

 
 

2. Lets Start! 
 

Go > Desktop > locate the SuperFox Program > double click 
 

The SuperFox Login screen will appear.  

SuperFox uses two levels of Security: Assistant Access and Full Access. Full Access allows 
access to sensitive data such as management reports and pay information. Assistant Access 
gives access only to non-sensitive parts of the program that most staff might use for routine data 
entry or children’s reports. 

First time you open the database default passwords will be set. These are as follows: 
 

“quickfox” (all lower case) for Assistant Access 

“superfox” (all lower case) for Full Access 

 

Once you start to use SuperFox with real data you will need to change these passwords to retain 
the security of your sensitive information. We will do this in one of the next steps. 

 

 

Click on drop down box beside Assistant 
Access > Choose “Full Access > Enter correct 
password > Login 

 

For details on this and more about security see 
Passwords Mini Guide. 
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3. Throughout the tutorial you will see instructions that start: 
 

Go > Home > etc 

It’s not an invitation to look for your coat and car keys. Instead this is the start of a set of keystrokes that 
will always work, no matter where you are in the program. 

During the tutorial you may be able to skip the initial keystrokes because you are already close to the 
function. You decide! Also, if you see the words *IMPORTANT* it means that you must pay careful 
attention to the instructions that follow otherwise your data will not be entered correctly. 

Many references are made throughout this tutorial to the Help files. This will assist  you get used to 
using HELP and/or the mini guides on an everyday basis for problem solving and to find out what else 
the program can do for you. 

 

4. Where to find Help 
 

There is a lot of very good help available with SuperFox. 
 

1) On-Screen Program Help. 
 
Nearly every form used by SuperFox also has a Help button. If you press a Help button it will take 
you straight to the help information that you need to use that form. The help is displayed in PDF 
format as this allows us to use nicely labelled diagrams and screen shots to explain how to use the 
different forms. 
 

You can browse all of the help topics from the 
drop-down menu at the top of the SuperFox 
window. 

 

 

This launches the Help browser. Click on a help topic on the left side of the browser to see the 
available help documents on the right hand side, here. 
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2) The Quickstart Tutorial 
 
The Quickstart Tutorial is a good place to go for a basic reminder of how to use the program and to 
check the right order to set up the program. 
 
 

3) Mini Guides 
 
All major topics have their own manuals called mini guides. You can find the mini guides and a 
copy of this tutorial from any part of SuperFox in a section called 

           Tutorials & Guides >  

 
The guides give a more in-depth explanation about a wide variety of topics than is possible in the 
Tutorials, and they often contain worked examples. The guides in the MUST READ column are a 
must before starting work! 

 
The Mini Guides and this tutorial do not assume that you are a computer expert! They always start 
with basic step-by-step instructions for each function in the program. If you are confident with a 
computer you can just skim through the more basic instructions. 

 
 

4) Copies Of The Quickstart Tutorial And Mini Guides - The Windows Start Menu 
 
 

The PDF help documents that are launched from help 
buttons and the Tutorials & Guides section of the 
program can be printed. They change occasionally 
and it is good to print as little as possible. 

 

You can find also copies of the Tutorial and Mini 
Guides from the Windows Start menu. You will need 
a PDF reader such as Adobe’s free Acrobat Reader 
installed on your computer to use these PDF 
documents. They are easy to find. 

 

 

 

 

 

 

 

From the Windows Start menu at the lower right 
corner of your screen choose All Programs. 

 

From the start menu go to: 

         All Programs > Helios > Documents >  

 

You will see two folders that contain the Mini Guides 
and the Quickstart Tutorial. The documents are listed 
in these folders and will launch when clicked. 
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5. The SuperFox Main Controls  

 

Now you have opened SuperFox have a look at the screen and find the following features: 

a. The Menu Bar, and the following words on it 

(1) File – allows you to exit the program (though clicking on the red X will do the same) 

(2) View : 

 will show/hide the Workflow Manager (the Workflow manager is the left hand 
window with brown words that allows you to access parts of SuperFox) 

 will show hidden Child, Adult or Staff records that have been chosen to be 
hidden (removed from sight, rather than deleted. 

(3) Workflow – clicking here will access all of the input Screens that SuperFox uses.  
                             It may be a little quicker to use this than the Workflow Manager screen. 

(4) Help – your on screen help, divided into all the main sections that SuperFox covers.  
                    Remember - nearly all input screens have a “Help” button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

b. Within the Workflow Manager locate the Back/Fwd/Home buttons. 

(1) To Hide the Workflow Manager:     Menu Bar > View > Workflow Manager 
 
(2) To Show the Workflow Manager:   Menu Bar > View > Workflow Manager 
 
(3) To get Back to the Welcome to SuperFox Screen: 
          Click “Home” (bottom left of screen) 
 
(4) To Navigate around the SuperFox options in the Workflow manager: 

 Click on the brown links (family details etc) 
 or click on the Back or Fwd buttons 
 or click on “Workflow” in the menu bar

Menu Bar 

Close 

Workflow 
Manager 

Back 
Fwd 
Home 

Maximise 
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6. TIP  – Find the HOME button and Use It 
Click on the “HOME” button if you get lost. It will always take you back to the start menu. All the processes in 
bold and italics in these notes start with the “Home” button.   I.e.  Home > etc 

 

This will take you to the start screen shown above. 

 

7. TIP  – MAXIMISE!! 
Make your on work area as big as possible. Click on the maximise button. It may make your screen bigger. If 
not don’t worry, it’s already as big as it will go. 

 

 

8. TIP  – Drag The Corners To Make Small Screens Bigger 
Many of the pop-up dialogs have quite a small size to work with very small screens. If you have room on 
your screen click and drag the bottom right corner to make the dialog bigger. In this case bigger is better! 

 

9. Loading Tutorial Dataset 2 

In order to prepare this tutorial you will need to load the correct dataset. Follow these instructions 
very carefully: 
 

Home > Backups & Tutorial Data > Tutorial Manager > click on DATA SET 2 (so that it is 
highlighted - see the screen below) > click “Load Selected Tutorial Data” 

 

 

 

When Dataset 2 is loaded the window title will change as shown above. Now you are ready to roll 
with Session 1. We will start by having a look to see how things appear in use. 
 

(This tutorial uses Tutorial Datasets 2, 3 and 5. They all load in the same way. If you need to 
return to the live data just come back here and press the Load Live Data button.) 
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10. Using the Change Date Control 
 

Many entries require the setting of a date, for example: 

Home > Family Details > Children > click on a child’s name and locate the control “Date of 
Birth” 

There are several ways to use the date control: 

 

 

  

 

 

 

 

 

 

 

Alternatively, if you want to set the date using a calendar, click on 
the downward pointing arrow in the date box. Note that you can 
change the year in this date selector by clicking on the year and a 
control opens up beside it to scroll up or down the years. 

 

EXERCISES: 

1. Change the date just using the keyboard arrow keys. 
2. Change the date by typing in numbers. 
3. Change the date by using the drop down calendar. 

 
It is worth practicing with dates as you will be using them quite a lot. 
 
 

11. Adding Setting Details 

 
The first thing that you will want to do when setting up SuperFox  
is to enter some basic details about your setting. These details 
 are all managed from the Setting Details part of the Workflow Manager, 
which looks like this: 
 
Home > Setting Details >  
 
 This is where we will be setting up key information about our setting, 
services and discounts, our opening hours, Families Information Service 
information, our setting registration limits, some text we can use to 
customise invoices, reminders and payslips and contact details for any 
voucher companies that we use. 
 
This information is already filled for our fictitious setting in Dataset 2. 
 
Home > Setting Details > Setting Details > 
 

We will have a quick look at this section. 

EASIEST 
Set a date by clicking on the day, the month or the year and 
use the UP or DOWN arrows on your keyboard to make 
changes. You can move between day month and year using 
your LEFT and RIGHT arrow keys. 
 
FASTEST 
Instead of using the UP or DOWN arrows you can also set the 
date by typing in: 
 

 Day number 
 Month number (e.g. July would be 7) 
 Year number 
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You would use the Setting Details section of SuperFox to enter your setting name, some key reference 
numbers and the setting contact information and a friendly name four your setting’s database file.  
 
Remember to press Save to save your work. 

 
 

 

 

You can optionally use the Change button to choose a logo for your letterhead. This is a nice touch and 
is easy to do. It is described in detail in the Mini Guide ‘Creating a Logo File’. 
 

The Security button is used to set new passwords. (See the Passwords Mini Guide.) 
 

The Invoice Offset button is used to set an initial invoice number. (See the Invoicing Mini Guide.) 
 

The Advanced… button is used to set up an advanced invoicing option and is not needed for most 
settings. (It is described in the Invoicing Mini Guide.) 

 

Speed Tip – Use the Tab key to move around forms 
 

 The quickest way to move to the next field on a form is to press the keyboard Tab key. 
 

 The quickest way to move to the previous field on a form is to hold down the keyboard Shift key 
whilst pressing the keyboard Tab key. 
 

 This is usually much faster than using the mouse and if you get into the habit of using the Tab key it 
can save you a lot of time when entering children’s details. 
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12. Setting Opening Hours 

 

SuperFox needs to know about the days on which your setting is open. It uses this information to 
enter children’s bookings and to prepare some management reports. 

 
Home > Setting Details > Opening Hours > 
 
This will take you to a tabbed form where our fictitious setting opening hours are set up for the 
year from September 2009 to July 2010. This is quite a big form and, if you have not already done 
so, this would be a good time to maximize the program. 

 

The Open Hours tab is used to set up continuous date ranges that your setting is open. The 
View Calendar tab allows you to easily see the open days. 

 

 

 
Each range is added as follows: 

 Click the Add Range button. 

 Click the Date Range button to specify the first and last dates in the range. 

 Give the date range a meaningful description. 

 Enter the number of hours that the setting will be open on each day of the week. 

 For now ignore the ‘Make Payment Date…’ part, it is used for Termly / Half Termly advance 
charging, more details can be found in the Opening Hours Mini Guide. 

 

Exercise 

Add a ‘Holiday Club’ date range running from 03-Aug-2010 to 25-Aug-2010. We will be open for 
just 3 hours on Tuesday and Wednesdays only. Press the Save button to save your work. 

When you have finished the exercise the new date range should look like the picture on the next 
page. 
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We can get a good view of the open days using the View Calendar tab and use the arrow 
buttons to roll the calendar forwards and backwards until it looks like this. 

 

 

You can see the open days for our new holiday club here in August. (You can use the sidebar to 
show individual date ranges on the calendar.) 

Note:  When you have a closed day in the middle of a date range (e.g. a mid-range bank holiday 
you will need to define two date ranges either side of the closed date. For most setting that are 
aligned with school term dates this only usually happens around Easter. 

In practice, setting up your opening hours is a small job that you will only need to do once a year. 
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The remaining setting details that we would add at this stage are very simple 
to set up and they are described in their own mini guides: 
 

 F.I.S. Profile 
 
A summary of the setting information that can be sent to the Families 
Information Service and included in your welcome pack. 
 

 Registration limits 
 
You can enter the overall number of children and any age specific 
number limits imposed by your Ofsted registration. This information will 
be used to check that bookings do not exceed the registration limits. 
 

 Courtesy Letter Text 
 
You can set up optional text to appear at the top and bottom of your 
invoices, reminders and payslips. 
 

 Voucher Companies 
 
The names and contact details of any voucher companies that you use. 
SuperFox will use these names to prepare summaries of vouchers 
received. 
 

Services Provided and Discounts are covered later in this tutorial. 

 

 

 

ENTERING STAFF DETAILS 
 

 

13. Staff Details  

SuperFox manages staff details from the staff details menu.     
 
Home > Staff Details > 

 Staff Details 
A large tabbed form that holds staff & volunteer details 
 

 Staff Summary Report 
A report that summarises staff details 
 

 Staff Emergency Details 
A summary of staff medical conditions & emergency contacts 
 

 Doctors   Doctor contact details 
 Dentists   Dentist contact details 

 
 Doctors & Dentists List 

A report summarizing doctor and dentist contact details. 
 

 Staff Details Form 
A printable blank form for new starters. 
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14. Add a Doctor and a Dentist  

Whilst it may seem unusual to be dealing with Doctors and Dentists so early on, they are the 
simplest people in SuperFox and it will be good practice for adding staff and families shortly. 

 Home > Family Details > Doctors > 

You will see the screen below with a list of Doctors on the left hand side and their details on the 
right hand side. (Many forms in SuperFox look similar.) 

 

 

Exercise: 

Add a doctor by pressing the Add Doctor button.  

Our new doctor is Dr Ivor Pain and both of his telephone numbers are 06666 999999. Remember 
to press the Save button when you have finished. (You will need to delete <New Doctor> to enter 
the doctor’s last name.) 

When you have added Ivor’s detail press the Save button and you should see: 

 

 
 

 

Exercise: 

Add a dentist from Home > Family Details > Dentists > Add Dentist button 

Our new dentist is Dr Phil Ing and both of his telephone numbers are 0888 999999. Remember to 
press the Save button when you have finished. 
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15. Adding Staff Members  

Staff and volunteer details are stored in a large tabbed form. 

Home > Staff Details > Staff Details > 

 

The information stored is used for administration and for safety reasons. Select Matthew 
Capybara from the Staff list.The tabs store the following information: 

 General tab – contact details, doctor, dentist and any medical notes. 
 

 Additional Details – job title, key dates, HMRC information, CRB and Paediatric First Aid 
status, holiday year and allowance. 
 

 Work types – The pay rates, if any, to be used for this person. 
 

 Qualifications – Qualifications, courses and baby experience. 
 

 Contacts – Emergency contact details. 
 

 Work Period – planning pay rates and any contracted hours. 

Adding a new staff member is very much like adding a doctor or dentist. You would simply press 
the Add button and fill in the new staff member’s details on each of the tabs. 

 
 
Volunteers 
 
Please remember to enter details for volunteers. If a volunteer is unpaid you should tick the 
Volunteer box on the Additional Details tab and this will exclude them from the payslip runs. 
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16. Work Types  

With Matthew Capybara still selected, click on his ‘Work Types’ tab. 

You can see that Matthew has two work types set up, ‘Playwork’ and ‘Training’ which are paid at 
different rates. 
 

 

 
 

Exercise: 

Add a new Happy Cleaning pay rate. 

Press the Add button at the bottom of the 
Work Types tab and enter the details shown 
here. 

 

 When you press ‘OK’ Happy Cleaning 
 should appear in the list of Matthew’s work 
 types. 

 

 
 Because each staff member has their own work types you have the option of setting their pay 
 rates to reflect their experience and responsibility. 

 

In SuperFox a Work Type is simply an 
amount of money that is paid to a member of 
staff for a unit of work. It could be an hourly 
rate, a day rate or a salary or even a one off 
payment.  
 

 A monthly salary might look like this. 

 

 The description that you choose will 
 appear on payslips. 
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“Quick Start” Section 2 
  ENTERING FAMILY DETAILS 
 

17. Family Details 

SuperFox manages family details from the Family Details menu. 
Home > Family Details > 
 
The options available are: 
 

 Family Centre – set up and work with your families 
 

 Children – work directly with children’s details 
 

 Adults – work directly with adults’ details 
 

 Doctors, Dentists – doctor and dentist contact details 
 

 Visiting professionals – contact details for visiting professionals 
(health visitors, dieticians, etc.) 
  

 Classes & Groups – put the children 
into classes and groups 
 

 Waiting List – enquiry management 
system 
 

 Printed Reports – sub-menu… 
 
 
The menu of children’s printed reports is 
very comprehensive. 
  
The children’s reports can all be filtered to 
include children in a given class or group. 
For example, you can produce reports just 
for a Mini-Bus pickup group or for a Nursery 
Class.  
 
There are two more report menus under the 
Printed Reports menu: 

 
Consent Summaries 
Summaries showing children with and without consents for 
Face Painting, First Aid, Outings, Photography or Sun Screen use.  
 
 
Family Registration & Mail 
A selection of family registration forms (blank or completed for verification) 
and useful mail merge data sources  
 

 

18. Exercise - Entering a New Family 

We are going to enter a new family now and the easiest way to do this is 
to leave Tutorial Dataset 2 loaded and to work through the ‘Entering 
Family Details’ mini guide.  
 
We will return to this tutorial when you have successfully added the Snail 
family! 
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19. Using the Family Details Printed Reports 

 
Hopefully Gary Snail is now happily registered with your setting! 
 
Producing the children’s printed reports is very simple, let’s have a look at an example. 
 
Let’s assume that our setting runs a mini bus and we collect and deliver some children locally. It would 
be good to take some emergency information with us when we leave the setting. This might include a 
summary of the children’s emergency contacts, just in case. 
 
Home > Family Details > Printed Reports > Emergency Contacts > 
 
The following form will pop up and ask you which children to include in the report.  
Click the By Grouping button and choose Mini Bus from the drop down menu. 

 

 

 

 

 

 

 

 

 

  

 
 
When you have chosen the group click OK and SuperFox will prepare a report looking like this: 
 
 

 

 
 
You can print or save these reports in a large variety of formats including PDF. There is a good 
description of how to use the printed reports in the Using Reports Mini Guide. 
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“Quick Start” Section 3 
  CALENDARS AND SERVICES 
 
 

20. Children’s Calendar / Timelines 

There are a number of useful interactive calendars in SuperFox. These all work in a similar 
fashion. The Children’s Calendar / Timelines display gives very good visibility of children’s 
bookings. 

If you are in a Workshop your tutor will demonstrate the Children’s Calendar / Timelines. If you 
are working independently this is a good time to work through the Children’s Calendar / Timelines 
Mini Guide. 

 

21. Entering Services 

 
SuperFox needs to know about the type of services that your setting offers in order to produce 
register pages, invoices, management reports, milk claims and Free Entitlement returns. 
 

The services are fully flexible and can be set up for hourly rates or session based care. They can 
also be used for childcare services or for purely financial transactions like T-shirts or registration 
fees. 

It is vitally important that the services are entered correctly so we will look at an example 
from Tutorial Dataset 2. 
 

Home > Setting Details > Services Provided >  

You will see a long list of the example services available at our setting… 

 

Now look at the Nursery Half day service by clicking on it in the list of services provided and then 
 pressing the Edit button. 
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The properties of a service are: 

 

 Service name 
 
SuperFox has predictive typing 
on many forms so they will be 
easier to use if you choose 
short names. 
 

 Unit Price 
 
The normal price you would 
charge for this service. The 
service will only appear on an 
invoice if a price is set. 
 

 Alternate Price 
 
An optional alternative price for 
this service. 
  

 Usual Start Time 
 
If your service is not purely 
financial you should set the 
usual start time. You can easily 
change the start time as you 
book the service.  
 

 Duration 
 
The duration (if any) of the service in hours. Services without durations (like T-shirts) will not appear 
on register pages. 

 
 Maximum Participants 

 
Some services may be number limited, leave this number set to zero if there is no limit. 

 
 Charging Options 

 
o Free Entitlement 

 
Select this option if the service is Free Entitlement. You should enter the reimbursement 
value of the Free Entitlement as the Unit Price as this is used by several financial reports. 
Free Entitlement services will always appear as zero priced on family invoices. 
 

o Use Sibling Discounts 
 
Select this option if this service is eligible for sibling discounts. (See Discounts mini guide.) 
 

o Use Manager’s Discounts 
 
Select this option if the service is eligible for management discounts. These can be granted 
to an account holder at the manager’s discretion. (See Discounts mini guide.)  
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                     Free Entitlements 
 
A correctly entered hourly Free 
Entitlement service look like this: 

 

 The Free Entitlement button is 
selected. 
 

 The reimbursement value of the 
hour is £3.00 
 

 A usual start time of 09:00 is set. 
This can be changed at booking 
time. 
 

 Duration of 1 hour is entered as 
we have set this up as an hourly 
service. 
 

 We have not set a maximum 
number of concurrent 
participants. 

  

 

 

 

 

Financial Services 

 

A correctly set up service which is 
purely financial, a sun hat sale, 
would look like this: 
 

 We are selling sun hats for 
£4.00 
 

 They have a price so they will 
appear on the family invoices. 
 

 There is no duration so they 
will not appear on register 
pages. 
 

 Because there is no duration, 
there is no need to set a usual 
start time. (This is because 
services without durations will 
not be included in a concurrent-
use check that is made when 
bookings are entered.) 
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It is very important to understand the distinction between these types of service and how they 
are set up correctly. You can find more information in the Services mini guide. 

 

Exercise 

Use the Services Provided Add button to add a new service called ‘Happy Cleaning Club’ with: 

 Unit price = £5.50 

 Discount price = £5 

 Usual Start Time = 16:00 (4pm) 

 Duration = 1.5 hours 

 Maximum participants = 18 

 The service is not a free entitlement and it is not eligible for sibling or manager’s discounts. 

 

(You can find the Happy Cleaning Club service in Tutorial Dataset 3 if you want to check your work.) 

 

 

 “Quick Start” Section 4 
  BOOKINGS AND INVOICES 
 

22. Recording Attendances 

There are two ways to enter children’s attendances in SuperFox: 

a) The Timesheet / Register Form 

This is a simple form that has tabs that allow you to enter attendances in register format or a 
timesheet format. This is a great place to enter small numbers of bookings, attendances, or 
one-off sales like sun-hats. 

The Timesheet / Register form is found in: 

    Family Accounts > Booking Centre > Register tab & Timesheet tab > 

  

b) Quick Bookings 

This is an interactive calendar that allows you to put bookings in for one or more children, 
groups or classes, services and dates in a few key strokes. Quick Bookings are verified for 
concurrent bookings, setting registration limits, room plans and optional service limits. 

Quick bookings can be used for individual families from:  

  Family Details > Family Centre > Calendar tab > Bookings option > 

Quick bookings can be used for individuals, groups and classes of children from: 

  Family Accounts > Booking Centre > Calendar tab > Quick Bookings option > 

We are going to start by putting in a couple of bookings with the Timesheet / Register form to 
explain how the program handles bookings. 
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23. The Timesheet / Register Forms 

 
With Tutorial Dataset 2 still loaded go to the Timesheet / Register form: 

 Home > Family Accounts > Booking Centre > Register tab > 
 
 

Let’s start by looking at the Register tab. This has three main areas. 

1 – The Register Date     

    2 - Attendances entered already     

          3 - A place to enter / edit attendances     
     

 

 

 

 

 

 

 

 

 
 

 

Exercise 

Let’s book in Cameron Porpoise for Pre-School on 9
th
 September 2009. 

a. Start by setting the date to 09 September 2009 
 

b. Now click on the next blank line (arrowed above) 
 

c. Press the tab key to take you to the Child field. This is a drop down list with predictive 
typing. We’re going to book in Cameron Porpoise, so start by typing ‘P’, and soon as 
Cameron’s name will appear. 
 

d. Press tab to take you down to the Service field. We are going to book Cameron in for 
Pre-School Day, so start by typing ‘P’ and Pre-School Day will soon appear. 

 
 

Next 
blank 
line 
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e. Press the tab key again and the default service attributes will appear. 
 

 
 

f.    You could at this stage change the content of any of the white boxes and you could apply 
an alternate price by ticking the Alternate Price box. We won’t do that yet. 

(Sibling Discounts and Manager’s Discounts are managed from the Family Accounts > 
Discounts > form, see the Discounts mini guide for more details.)  

g. We won’t do that, just press the Save button and the new attendance will appear in the 
‘View Current Register’ list. Job done!  
 
(You would just press Tab to continue entering register entries.) 
 

 
 

The Register tab is the right place to enter small numbers of services charged in arrears, for 
example extra or stay-late attendances transcribed from the setting register at the end of the day. 

The Print Register button is one of the places that you can print the day’s register pages. We 
 will have a look at an example register page from Tutorial Dataset 3 shortly. 
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Higher volume bookings can be entered from the Timesheet Tab or by using Quick Bookings. 

Let’s have a look at Cameron Porpoise’s timesheet, click on the Timesheet Tab. This works in 
much the same as the Register Tab but here the context is the child’s name rather than the date. 

 

The Timesheet tab has several extra functions that are better used when looking at all of the 
child’s bookings: 

 Advance Bookings – one of the methods of adding repetitive bookings in quantity. The 
Quick Bookings function has largely superseded the Advanced Bookings button. 
   

 Multiple Delete button – deletes large numbers of this child’s un-invoiced bookings. 
 

 Multiple Cancel button – cancels large numbers of this child’s invoiced bookings. 
 

 Toggle Alternate Price button – quickly change whether or not to use alternate prices. 
 

 Choose charge date for this booking – allows you to set a date on which the     
            service will become payable. Useful for pay in advance bookings. 

The timesheet is a good place to cancel a small number of unused bookings for an individual 
child. Bookings can also be cancelled from the Family Centre and Booking Centre Calendars, 
which are better suited to large numbers of cancellations e.g. on snow closure days. See the 
‘Cancellations, Credits & Refunds’ Mini Guide for more details. 

Note: 

To keep the timesheet list short the child’s bookings are removed from view on the timesheet 
when they have been invoiced and used. You can always see them on the register tab, the 
calendars and from the View A Family’s Account form in Family Accounts and in the Family 
Centre. 
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Flipping Between Timesheet and Register View  

You can flip in between the current timesheet view and the current register view, and vice versa, 
just by clicking on the tabs at the top of the form.  

If you hold down the 'Ctrl' key while you click between the two views you will maintain the 
context you are working in: 

 Register to Timesheet - will go to the timesheet of the child in the current highlighted 
register entry. 
  

 Timesheet to Register - will go to the date of the attendance that is highlighted in the 
child's timesheet.  

Remember you will then need to click in the 'Current View' window to see the current 
timesheet or register entries. 
 

 

DELIVERY DATES AND CHARGE DATES 

Each service that you provide has two dates associated with it. You can see these listed on the 
Register and the Timesheet tabs. 

The Delivery date is the date on which the service will actually be used. 

The Charge date is the date on which you will ask for payment for the service you have provided.  

The charge date must be set when you make the booking if you intend to invoice in advance. 

If you do not set the charge date SuperFox will set it to be the same as the delivery date, it is a 
pay in arrears option. The bookings will become payable as they are used. 

 

To charge in advance you will need to choose a charge date.  
 

 

 

It is easy to set a charge date for a booking using the 
‘Choose a Charge Date for this booking’ box on the 
timesheet or register forms. 
 
When entering the booking. You can then choose from 
the following options: 

 

 Choose ‘Pay in Arrears’ (the default option) the services will be payable as they are used. 
 

 Choose ‘Pre-calculated Date’ to apply a common pre-payment scheme. 
 

 Choose ‘Specific Date’ to set a specific date on which the booking will be payable. 
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The pre-calculated charge dates that you can choose from the drop-down menu are: 
 

Termly / Half Termly in Advance  
 
If you have set up charge dates for the Opening Hours date ranges then you can choose to use these 
as the booking charge dates for the register date. 
 

Weekly in Advance (Last Day) 
 
This will set the charge date to be the Sunday before the booking day. 
 

Weekly in Advance (Specific Day) 
 
As above, but choose a day of the week to use as a charge date. 
 

Monthly in Advance (Last Day) 
 
This will set the charge date to be the last day of the previous month. (This is a good choice for monthly 
advance bookings.) 
 

Monthly in Advance (Last Open Day) 
 
This will set the charge date to be the last open day of the previous month. If the previous month does 
not have a last open day the program will use the last day of the month. 
 

Monthly in Advance (Specific Day) 

As Monthly in Advance but choose a day of the month to use as a charge date. The day can only be 
chosen from the range 1 to 28 to avoid causing a problem with February. 
 
You can enter bookings with more unusual charge date schemes using Quick Bookings. Any 
user defined schemes will appear at the end of the Pre-Calculated charge date list. 

 

24. Tutor Demonstration - Quick Bookings 

The easiest way to enter higher volume bookings is to use the Quick Bookings function. 

This is a clickable interactive calendar that allows you to enter childrens bookings very quickly. 

The quick bookings function can handle: 

 Individual children, groups or classes. 
 Individual services, daily or weekly service templates. 
 The advance charging schemes listed above. 
 User-defined charging schemes, e.g. fortnightly in advance. 

If you are in a SuperFox Workshop your tutor will now demonstrate the Quick Bookings function.  

If you are not in a workshop please pause here go through the Quick Bookings Mini Guide. 
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25. Printing a Register Page 

 

We are going have a look at one of the printed register pages that can be produced by SuperFox.  
 

Start by loading Tutorial Dataset 3: 

 Home > Backups & Tutorial Data > Tutorial Manager > Select Dataset 3 >  
       click Load Selected Tutorial Data button > 

 
 
 You can print register pages from two places in SuperFox: 
 

1)  From Family Accounts > Booking Centre > Register Tab >  
 
    Simply click on the ‘Print Register’ at the bottom of the register tab. 

 
 

2)  From the right click menu on the ‘Children’ calendar in: 
 

 Family Accounts > Booking Centre > Calendar tab > (Choose Children view) > 
 
 Family Details > Family Centre > Calendar tab > (Choose Children view) > 
 
 
Exercise: 
 
Go to:   Home > Family Accounts > Booking Centre > Calendar tab > Children view > 
 
 

 
 
 
Use the right mouse button to click on Monday 2nd

 November 2009. (You may need to 
scroll the calendar using the arrow buttons to get this date on the calendar.) 
 
Now choose the Print Register for this day option from the pop-up menu. 
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This register options form will appear, use this form to choose the style of register page you would 
like.  

 
You can optionally include the children’s ages or colour code their register entries to indicate their 
Ofsted age band. (If you choose to use them the colour coding corresponds with the colours used 
on the children’s timelines.) 
 
Now choose the options shown below: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You could choose to print (or save) several types of register page: 
 
 Register  – arrival & departure times 

 
 Advance bookings – a detailed list of the sessions attended. 
 
 Blank register page – useful for drop-in attendances. 
 
 Weekly register – a simple summary of AM and PM attendances for a week. 
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You can also filter the register reports to include only the children who are: 
 

 In a given group or class 
 
 Attending a specific session 

 
 In a given age range 

 
You can also choose the sort order that the children will appear on the printed register and advance 
booking reports by name, session or start time. 
 
You can also tick the last box to choose to use produce register pages ordered using the children’s 
first names rather than their last names. 
 
The different types of register page are described in more detail below. For the start and end time to 
be correctly calculated you will need to specify start times when booking the children into the setting. 
 
Classes and groups are managed from the Family Details > Classes and Groups > option. 
 
 
 
 
The first type of printed register is the most commonly used option and is a list showing children's 
arrival and departure times at the setting. Any filtering applied is shown at the top of the register 
page. (Name and start time filters are useful for this report.)  
 
 

 
 
 

The columns printed are: 
 

 Child’s name and optional age with colour coded Ofsted age band. 
 

 Expected start time with a space to the right for actual start time if different and a signature 
 

 Expected end time with a space to the right for actual end time if different and a signature 
 

 If you need to distinguish between two children with the same name you can set nicknames 
for one or both of the children in the Family Details > Family Centre > Children’s Details 
tab > 

 

See the Register Pages mini guide for more details about the printed register pages.
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26. Recording Payments Received From Parents: 

 

Payments received can include vouchers, standing orders direct debits and BACS transfers. 

Still using Tutorial Dataset 3: 

 

Home > Family Accounts > Payment Received >  

Click latest entry under “View Current Payments” (with a date but no name) (entry 
becomes a blue line)… 

 

 

… > under “Add New Data” in lower window find Date > select day that you want 
entered > enter details against name (easy entry – just start typing surname) – enter 
amount, payment type and notes > click Save 

Tutorial – add a £50 Voucher Payment from the Whale family on 21 September 2009. 

  

Any ‘Notes’ that you enter along with a Payment Received will appear in other reports, so please 
only type things that you don’t mind other people seeing!   

 

You can select a family either by choosing the name of the ‘Head of Family’ or by choosing the 
name of any child who is in the family (the payment still relates to the family account, it is not 
allocated to the specific child). 

 

This is also the right place to enter a refund from your bank account to a parent in the same way 
as a payment received, but tick the ‘Make this a refund’ box. See the Cancellations, Credits and 
Refunds Mini Guide for more details. 
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Cash, Cheque and Bank Payments Received Directly From Parents 
 

SuperFox treats this income as it were all cash received from parents. Here is how you should 
process these payments: 

 Record the amount received, payment method and family name on paper in the setting as 
usual. 

 Before producing the next invoice run enter the payments received into SuperFox. 

 Produce a bank run summary. 

 Bank the cash and cheques. 

 Reconcile the DD, SO and BACS items on the summary against your bank account. 

 

Please read the Cancellations, Credits and Refunds mini guide to find out how to make account 
credits and refund payments using SuperFox. 

 

 

Indirect Payments Including Vouchers or Salary Sacrifice Schemes 
 

Voucher and Salary Sacrifice income is treated differently to fees received directly from parents. 
This is because the payment comes from a third party. Typically for vouchers either: 

 

 You will need to reclaim the voucher payments from the voucher company (or salary 
sacrifice scheme), or 
 

 A deposit will be credited automatically to your bank account which you will need to 
reconcile with your records. 
 

 The reimbursement may occasionally be incorrect or significantly late. 
 

 

SuperFox helps you deal with both of these scenarios. 
 

 Set up the names of the Voucher Companies (or salary sacrifice schemes) in the Setting 
Details > Voucher Companies > section of SuperFox. 
 

 Enter vouchers received, or notified payments, under Family Accounts > Payments 
Received > 
 

 Produce a Voucher Run Summary. 
 
When you actually receive a payment from a voucher company or salary sacrifice scheme you 
should enter it as 'Income (non-P&L)' - more of this later! 

 

Free Entitlement Income 

The Free Entitlement is free at the point of delivery and is paid for by a grant which you will need 
to claim from your local authority. 

When your free entitlement funding or voucher reimbursement money is paid... 

Enter it as an 'Income (non-P&L)' item in the Setting Details > Setting Transactions > form - more 
of this later!  
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27. Creating Invoices 

 

SuperFox can provide comprehensive, automatic invoicing for your whole setting with just five 
clicks of a mouse button! 

First the children’s attendances and the payments received must be up to date. 

 

Let’s create an invoice batch. Check that Tutorial Dataset 3 is loaded and then go to: 

Home > Family Accounts > Statements / Invoices > 

Click on the Add button and enter a cut-off date of 30 September 2009, like this. 

 

 

 
If you feel it would be helpful you can add some notes about the invoice run. When you are done press 
the ‘OK’ button and SuperFox will generate the invoices. 
 
 
 
IMPORTANT – YOU NEED TO UNDERSTAND THIS… 
 
Account line items will be included in this invoice run if they have not yet appeared on an invoice and 
they have a charge date up to and including the cut-off date. 
 
Payments received will be included in this invoice run if they have not yet appeared on an invoice and 
they have a received date up to and including the cut-off date. 
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When the invoice batch has been prepared it will appear 
in the list to the left of the form. 
 
 
 

Viewing / Printing An Invoice Batch 
 
 
When you have created the new invoice batch use the 
‘View’ button to display the invoices on screen. A small 
form will pop up. 

 

You can choose to produce invoices for active accounts 
only, active accounts plus accounts owing money, all 
accounts or for an individual account holder. (An account 
holder is a Family Head or any other adult with account 
line items held in their names.) 

 
 
You can title the report as ‘Statement’, ‘Invoice’ or with a 
few words of your choice (e.g. ‘Your Bill’.) 

 

 
You can also choose which style of invoice to produce.  

There are three styles of invoice that show different 
levels of detail. 
 

1)   Fully Itemized 
 
This option shows each line item used by each child. It gives parent the most information about 
their childcare and uses the most paper to print. 
 

2)   Summary Information Only 
 
This option shows the least detailed information about a child’s setting use. It shows simple 
totals for the paid items, free entitlement and other items for each child for the entire invoice 
period. This option uses the least paper to print. 
 

3)   Daily Information 
 
This option shows daily information about a child’s setting use. It shows totals for the paid items, 
free entitlement and other items for each day that a child is in the setting. This is worth 
considering instead of the fully itemized option if child are using multiple services each day. 

 
You can print all or some of the invoices in the batch at any time. You can also save the invoices in a 
variety of useful formats.  

 
TIP! 

Before printing anything skim through the on-screen invoices and check for gross errors. If necessary 
delete the invoice batch, correct the errors and start again. 

Remember - an easy way to do this is to use the gold tree control on the report toolbar. 

Detailed instructions for saving, printing and skimming through reports are given in the Using Reports 
mini guide. 
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There will be at least one page per active family during the period of the report. View the pages of the 
report using the navigation buttons on the report toolbar.  

 

The report toolbar looks like this  

 

Invoices are designed to be used with standard window envelopes. A fully itemized invoice looks like 
this: 

Window Envelope Address   

    Invoice Date and Number 

Setting Letterhead & 
Statutory Information 

 

 

Customizable Text: 

 Top (something 
like thank you) 

 Bottom (what to 
do next, how to 
pay) 

 

Statement summary 

 

Itemized usage for 
each child: 

 Paid Hours 

 Free Entitlement 
Hours 

 Items that don’t 
have durations – 
like hats and 
fines. 

 

 

 

 

The letterhead information is set up in setting details: 

Home > Setting Details > Setting Details > 

 

The first invoice number can be set up in setting details: 

Home > Setting Details > Setting Details > Invoice Number button > 

 

The custom text can be set up in: 

Home > Setting Details > Courtesy Letter Text > Statements / Invoices >  
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To view one invoice click on the gold group button in the report toolbar and click on the family name in 
the list to the left side of the report. 

 

 

 

 

EXERCISE 

Look through the 30 September 2009 invoices (fully itemized) and answer these questions: 

What are the dates spanned in this run of invoices? 
 
How much the does the Porpoise family owe? 

Do the Doormouse family owe any money? 
 
Which voucher company have the Whales been using? 
 
How did the Goose family choose to pay? 
 

Try viewing the invoices as ‘Summary Information Only’ and as ‘Daily Information’. 

Finally delete the Invoice run using the delete button. 

 

 

Invoice Batch Reports 
 

The ‘Balance’, 'Sales' and 'Funded' buttons produce plain formatted summaries that accompany the 
invoice batch. These are suitable for use in spreadsheets.  

 

 

If You Do Not Collect Any Fees 
 
If you do not collect your own fees you may want to use the Setting Details > Setting Details > Advanced 
Button option to disable account balances   
 
‘Disable balance accrual’ will zero the outstanding balances for all family accounts in the database.  
 
The statements will not show a balance brought forward, just the fees payable this period.  
 
Because the account balances will be wiped out permanently always make a backup before 
using this option. 
 



  
 Software for Childcare Superheroes.  © Helios Computing Ltd. 36 

28. Bank Runs - Paying In Money 

SuperFox will help you prepare for a Bank Run (the “Bank Paying-In Summary”), keeping track of 
what has been paid in to the bank and facilitate a Bank Reconciliation. 

Details for the Bank Run are taken from the Payments Received records. These must be kept up 
to date regularly otherwise details will be missing in the Bank Paying-In Summary and from 
parent’s invoices and statements. (Vouchers are not included in the Bank Paying-In summary as 
you have to reclaim these separately.) 

 

EXERCISE 

Using Tutorial Dataset 3: 

Home > Family Accounts > Bank Paying-In Summary > Add > enter Cut-off-date & Notes… 

Enter 16 September 2009 > OK > View the report  

 

 

The Bank Paying-In summary has three sections. The first two are designed to help with the ‘I 
filled in the paying-in slip wrong again’ blues. The third section summarises other payments 
received direct (standing orders, direct debits, BACS, etc.) from parents and is useful for bank 
statement reconciliation. 

 

 A summary of cash payments received. 

 A summary of cheques received. 

 A summary of other types of payments received from parents (excluding vouchers). 
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29. Processing Vouchers (Optional: If Time Available) 

 

SuperFox will collate Vouchers received and provide a summary of the voucher payments to 
reclaim or reconcile from each voucher company. This is a handy summary to use when 
reclaiming your vouchers received by whichever method you have agreed with the voucher 
provider. 

The receipt of Vouchers must be recorded along with other cash / cheques etc in the “Payments 
Received” screen otherwise details will be missing in the Voucher Summary. 

You generate the voucher runs in exactly the same way as you did for the Bank Paying-In 
Summary. 

 

EXERCISE 

Using Tutorial Dataset 3. 

Home > Family Accounts > Voucher Summary > Add > enter Cut-off date and Notes > OK >  

Tutorial:  Produce a Voucher Summary with a cut-off date of 30 September 2009. Which 
voucher companies are we expecting to pay us? 

 

 

 

 

 

The program produces a separate summary for each company that has an active Voucher claim 
against its name during the run. Click the yellow tree button to select a given voucher company. 

If you typed in the voucher number as the description when you used the ‘Payments Received’ 
screen, the voucher number will be listed in the ‘Description’ column of the Voucher Summary. 

This is a pretty handy summary that will at least take some of the work out of reclaiming or 
reconciling your voucher payments. 
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“Quick Start” Section 5 
  FREE ENTITLEMENTS AND MANAGEMENT REPORTS 

 

 

30. Early Years Reports 

 

SuperFox has several Early Years reports in: 

Management Reports > Early Years Reports > 

 

These include a milk claim report, a couple of Free Entitlement headcount returns and the pupil 
level data required for the Early Years Census. 

 

 

 

 

 

 

If you are in a workshop your tutor will demonstrate the Headcount Return. If you are working 
independently you might like to work through the ‘Headcount Returns’ Mini Guide. 
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31. Management Reports (Optional, if time is available) 

 

SuperFox management reports can give you a good picture of who is using your setting and what is 
happening with the money. They are good tools for planning the development of the setting and can be 
very useful when applying for funding. 

Where possible the SuperFox management reports use graphs that are easy to understand at a glance. 
The main management reports available in SuperFox include (there are others): 

 

Setting Finances 
 

This section includes a cash book type form to enter rent, staff costs and other 
setting income and expenditure which enables you to produce some basic 
financial statements (they do not replace your treasurer or accountant): 

 

 CASH FLOW GRAPH 

Showing the change in a setting’s cash and where it was made and 
spent over a date range. 

 

 PROFIT AND LOSS 

A small wizard guided report showing key financial measures. 

 

 CAPITAL EXPENSES 

Showing the setting’s capital expenses and when they occurred over a 
date range. 

 

 REVENUE EXPENSES 

Showing the setting’s revenue expenses and when they occurred over 
a date range. 

 

Usage Reports 
 

 USAGE BAR CHARTS 

Showing attendances for a given date range in terms if fees and childcare hours provided. 

 

 USAGE PIE CHARTS 

Showing setting use by service type, family, gender and age. 

 

 FULL TIME EQUIVALENT BAR CHARTS 

Showing attendances in terms of FTE and the percentage of places occupied. 

 

Early Years Reports 
 

Milk claims, funded usage summaries for estimates & reclaims and the Early Years Census. 
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32. Example: Usage Bar And Pie Charts 

 

We are going to start by taking look at just one of the many charts in SuperFox; the Usage Bar Chart. 

Load Tutorial Dataset 3. (This has one year of attendances from September 2009.) 
 

 
Home > Management Reports > Usage Reports > click on ‘Usage Bar Chart’ > 

 
 
 
 
The Histogram Options form will pop up and ask you to 
select the start date and the date range that you would 
like to use for your Bar Chart. 
 
The date control works in the usual way. The date ranges 
that you can choose to plot are: 

 30 Days    (Useful to show one month)  
 60 Days    (Useful to show a half term)  
 20 Weeks  (Useful to show a term)  
 1 Year    (Useful to show annual usage trends)  

Choose 19
th

 April 2010, a 30 day date range and click 
on the 'OK' button to continue.  

 

The 'Select Report Data' form will now be displayed. Use the radio buttons to select the data to plot. 
(The example below would produce a report based on attendances at the 'Explorer’s Club’.)  
 

 

 

Choose ‘All Data’ and press the ‘OK’ button
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SuperFox will then generate the Usage Bar Chart that looks like this: 

 

 

 

The top bar chart shows usage in terms of fees charged. These figures are taken from the invoiced 
sessions and include the reimbursement value of the Free Entitlements. (Although you are not charging 
families for the Free Entitlement the setting is still earning money for providing the service.) 

The bottom bar chart shows usage in terms of hours of childcare provided, they are not necessarily the 
same, especially if sessions have a range of hourly costs or if discounts are used. 

You can see that there is a difference in the amount of childcare and income generated between days of 
the week. (You can also see the May Bank holiday in the middle of the date range.) 

A table showing the numeric value of each bar is given on the second page of this report. 
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Now that we have had a look at the amount of daily usage, it would be helpful to know just how the 
setting is being used during this period. 
 
Home > Management Reports > Usage Reports > click on ‘Usage Pie Chart’ > 
 
 
 
 
Choose the same 30 day date 
range from 19 April 2010 to  
18 May 2010. 
 
 
 
 
 
 

 

The 'Select Data and Chart Options' form will now be displayed. Use the radio buttons to select the data 
to plot. (The example below would produce a report based on attendances at the 'Explorer’s Club’.)  

You can also use the ticked check boxes to choose which pie charts that you would like to produce 
(Options that would always produce undivided pie charts are greyed out.) 
 
 

 
 
 

Choose ‘All Data’ and press the ‘OK’ button 
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SuperFox will then generate the Usage By Type pie charts that look like this: 
 
 

 

 

 

The report contains two sets of pie charts: 

 Set 1:  Fee Income by… 
 

 Set 2:  Hours by… 

 

This is the same idea as used in the Usage Bar Charts. The first set of pie charts tells you about how 
the setting income was generated. And the second set tells you about the hours of childcare delivered. 

If you have produced the pie charts showing usage by ethnicity then the last page of the report will 
summarize the ethnicity codes that appeared in the report. 

The bar and pie charts are good communication tools that are well suited for use in management 
meetings attended the setting treasurer and senior childcare staff. 

 
It is easy to see the connection between what is happening in the setting and the setting’s financial 
performance and to use this information to guide the setting’s development plans. 
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And Finally... 
 

 

33. Backup Your Data Frequently! 

 

Every time you have entered any data that you would miss (like the month's attendances) keep 
your work safe by making a backup. 

You should also make a backup if you are about to upgrade SuperFox or try out a new function 
for the first time 

The backup files are not big and individual files can easily be deleted when you are sure they are 
no longer needed. 

 

Important Tip - Take Backups Off Of Your Computer 
 

Sometimes bad things happen to good computers! 

It is surprisingly easy to kill a computer. They sometimes catch viruses 
or simply stop working. We have even filled one with coffee. 

Do not rely on backups stored on the computer. We recommend that when you make a 
backup you move the file off of your computer, for example using a USB flash drive. 

 

Important Tip – Keeping Backups Off Site Is Good 
 

Sometimes bad things happen to good settings! 

If you are unlucky your computer could be damaged or stolen. Every 
year a small number of settings flood, catch fire or are burgled. 

If you do not have a fire and flood-proof safe it would be best to keep a copy of your backup files 
at a different secure location. 

 
Notes 

We do not currently recommend using an on-line file store for storing your backups unless you 
are completely confident about the service’s security and availability. 

In order to make a backup you will need to be using SuperFox from a user account with Windows 
Administrator privilege. 

Remember to set the SuperFox passwords for the each database to help keep the backed 
up data safe. 
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SuperFox will offer to make backups before performing some operations and before you exit the 
program. It is also easy to make a backup whenever you like. 

Go to the Backups & Tutorial Data Section and select the 'Backup Your Data' option. 

 Home > Backups & Tutorial Data > Backup Your Data > 

 

Use the ‘Browse’ button 
to find or make a folder 
on your computer to use 
for the backup. 

SuperFox will remember 
the folder that you 
choose or make and it 
will continue to use it for 
backups until you specify 
a different folder using 
‘Browse’. 

You can include a 
‘friendly name’ to include 
in your backup file name 
which is very useful if 
you deal with more than 
one setting. 

 

 

 
 

When you have chosen a 
folder go ahead and click 
on the 'Backup' button at 
the bottom of the screen. 
SuperFox will create your 
backup file and confirm 
that the backup was 
made successfully. 

 

If you wish to put the 
backup file in a new 
folder simply use the 
‘Make New Folder’ button 
while you are browsing as 
shown below. 
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Backup File Names 

SuperFox backups now all contain a Date, Number and a Name to help you to find the backup 
that you need to restore in the event of a problem. 
 
      e.g     SuperFox_Backup_Date_Number(Name).sbf 

Date      

This is the date that the backup was made. The date is written ‘backwards’ with the year followed 
by the month followed by the day. 

 The date as:  yyyymmdd   e.g.   20110621 is  21
st
 June 2011 

 
This ensures that more recent backups will appear at the top of folder lists if you have many 
backup files with similar sounding names. 
 

Number 

It is important to be able to see which backups came first or last if you make several backups that 
have the same name in the same folder on the same day. SuperFox uses a number from 000 to 
999 to show the order in which the backup files were created. 

 e.g.   SuperFox_Backup_date_000(name).sbf  first 

  SuperFox_Backup_date_001(name).sbf  second 

  SuperFox_Backup_date_002(name).sbf  third 

Name 

This is a friendly name that you can give to the database which can be set up in either of two 
places the program (both places do the same thing): 

1)  Setting Details > Setting Details > 

 

 

         Here 
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2) Backups & Tutorial Data > Manage Your Data > 

 

 

 

 

 

  

  Here 

 

 

 

 

We highly recommend setting up setting friendly names to use with the setting’s files. Friendly 
names are useful to everyone, and especially useful for users with multiple settings. 
 
Please read the Data Backups mini guide for more information about making and restoring 
backups. 

 

34. Compacting the Database for Speed 

 

It is a worthwhile exercise to occasionally compact the database. This can improve the speed of 
operation and keep the database file to a reasonably small size. It is something that you should 
do about once every year, or if you notice the program starting to slow down a bit for example 
when you are entering bookings. 

Important - You should always take a backup prior to compressing the database! 

To compact the database: 

 

1. Home > Backups & Tutorial Data > Backup Your Live Data > make a backup 

2. then still in Backups & Tutorials > Compact Database > 

 

When SuperFox has finished compacting the database it will display a small message to confirm 
that the compact operation is completed. 

 

Note: 

You will need to run SuperFox from an account with Windows Administrator privilege to compact 
the database. 
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35. What To Do Next? 

 
 
 
 
During this tutorial we have looked at some of SuperFox’s main features including: 

 How to find your way around the program. 
 Where to find help. 
 How to enter family details. 
 How to work with bookings and invoices. 
 How to prepare Free Entitlement returns and some management reports. 

There are many other functions in the program and these include: 

 Flexible room planning, capacity planning and staff scheduling. 
 Setting manager and staff diaries. 
 Staff holiday, sickness and absence tracking. 
 Gross pay statements 
 A financial planner 

 

If you like the look of the software and might want to use all or part of it in your setting please 
spend some time practising with the Tutorials and Mini Guides before working with your setting’s 
live data. Good places to start are: 

  

1) Use the Quickstart Tutorial and Mini Guides that are included with SuperFox. 

 
The Quickstart Tutorial is a slightly longer tutorial that covers more of the program 
functions. The Mini Guides cover major functions in more detail than the tutorials. 
They include step-by-step instructions and worked examples for important topics. 
Remember that you can read and print the Tutorial Mini Guides from the Tutorials 
& Mini Guides section of the program or from the Windows Start menu. 

  
 

2) Try running in parallel with your existing system. 

It is a good idea to run SuperFox in parallel with your existing 
administration system for a while to help you to become confident in it’s 
correct use. If you have been running in parallel with an existing system 
you can wipe out your practice financial information, still leaving the 
family, staff and service data intact using 

Backups & Tutorial Data > Manage Your Data > Fresh Start button > 

And of course, remember to take frequent backups! 

 

 

THIS IS THE END OF THE “Quick Start” TUTORIAL 


